
QUICKBOOKS ONLINE 
UPGRADE INSTRUCTIONS
Small Business / Freelancer / Advanced

Introduction 
As Park Bank completes its system upgrade, QuickBooks Online settings will need to be updated 
to ensure transition of your data. Please reference the dates next to each task as this information is 
time sensitive. To complete these instructions, use your login credentials for online banking.

It is important that you perform the following instructions exactly as described and in the order 
presented. Thisupgrade should take 15–30 minutes.

Documentation and Procedures 
Upgrade – Information only 

QuickBooks Online data is stored on Intuit servers in the cloud. Since we update your records   
with every change, we cannot restore your file to a previous point in time.

QuickBooks Online automatically updates your selected version so you are always on the  
latest release.

IMPORTANT: QuickBooks Online connectivity services may be interrupted up to 5 business  
days after the upgrade is complete.

TASK 1: Optional task - Complete a final download before 06/05/2020

NOTE: Please skip to Page 3 if you Manually Import Transactions.

1. Sign in to QuickBooks Online.
2. Click Banking.
3. In the top-right area, click Update.
4. After your download finishes, click the For Review tab to confirm items downloaded.
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TASK 2: Match Downloaded Transactions
1. Accept all new transactions on the Banking page. Simply check off all the New/Matched  

transactions and click Batch Action to “Accept Selected”.  
2. Assistance on matching transactions is available in the Help menu > Search for Matching  

Transactions and follow the instructions in the appropriate article.

TASK 3: Deactivate Accounts in QuickBooks Online on or after 06/05/2020
1. Select Banking on the left column.
2. Click on the account you would like to disconnect, then click the Pencil Icon.
3. Click on Edit Account Info.
4. Check the box next to Disconnect this account on save.
5. Click Save and Close.
6. Repeat steps 2-6 to deactivate additional accounts.

TASK 4: Reconnect Accounts at Park Bank Madison on or after 06/15/2020
1. In the upper-right area, click Add Account.
2. Enter Park Bank Madison.
3. Click Park Bank Madison in the search results below.
4. Type your login credentials. Click Continue.
5. Provide any additional information requested, to proceed.
6. Ensure you associate the account for Park Bank Madison to the appropriate account already  

listed under Which accounts do you want to connect? Select the matching accounts in the  
drop-down menu. 

IMPORTANT: Do NOT select +Add new. If you are presented with accounts you do not want   
to track in this data file, Uncheck the box next to the Account name.

7. After all accounts have been matched, click Connect.
8. When the download is finished, you will return to the Banking page.

TASK 5: Excluding Duplicate Transactions 
1. Choose Banking.
2. In the For Review section, click the checkboxes for the transactions you want to exclude.
3. Click Batch Actions > Exclude Selected.

NOTE: If you accidentally exclude a transaction, you can include it again.
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TASK 6: Undo Excluded Transactions 
1. Choose Banking.
2. Click the Excluded tab.
3. Click the checkboxes for the transactions you want to include.
4. Click Batch Actions > Undo.
5. Transactions will appear again in the New Transactions tab for you to work with.

Additional Instructions: Need to Manually Import Transactions?
1. Log in to www.parkbank.com.
2. Download one of the following Web Connect file types:

• .qbo (QuickBooks)
• .qfx (Quicken)

3. In QuickBooks Online, choose Banking.
4. In the upper-right corner, click File Upload.
5. Click Browse and select the Web Connect file from your computer. Click Next.
6. Select the appropriate account from the drop-down menu. Click Next.
7. When the import is completed, click Let’s go!
8. After your download finishes, click the For Review tab to see what was downloaded.

Thank you for making these important changes!

www.parkbank.com • Member FDIC
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QUICKBOOKS FOR MAC 
UPGRADE INSTRUCTIONS
Web Connect

Introduction 
As Park Bank completes its system upgrade, you will need to modify your QuickBooks settings 
to ensure the smooth transition of your data. Please reference the dates next to each task as this 
information is time sensitive. 

To complete these instructions, you will need your login credentials for online banking.

You should perform the following instructions exactly as described and in the order presented.  
If you do not, your online banking connectivity may stop functioning properly. This upgrade should 
take 15–30 minutes. 

Thank you for making these important changes!

Documentation and Procedures 

TASK 1: Upgrade Preparation

1. Back up your data file. For instructions to back up your data file, choose the Help menu and 
use the Search bar available at the top. Search for Back Up and follow the instructions on 
screen.  The first time you do a backup, QuickBooks will guide you through setting backup 
preferences.

2. Download the latest QuickBooks Update. For instructions to download an update, choose  
Help menu and use the Search bar available at the top. Search for Update QuickBooks, select 
Check for QuickBooks Updates, and follow the instructions.

TASK 2: Optional task - Complete a final download before 06/05/2020

1. Log in to www.parkbank.com and download your QuickBooks Web Connect File. 
2. Click File > Import > From Web Connect.
3. Link your bank account with the existing QuickBooks account and click Continue.
4. Repeat steps for each account.
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TASK 3: MATCH DOWNLOADED TRANSACTIONS

If new transactions were received from your connection, accept all new transactions into the   
appropriate registers.

If you need assistance matching transactions, choose the Help menu and use the Search bar  
available at the top. Search for Updating Your Register, select the article with that name, and follow 
the instructions.  

NOTE: All transactions must be matched or added to the register prior to disconnecting   
your accounts.

TASK 4: Disconnect Accounts in QuickBooks on or after 06/05/2020
1. Choose Lists menu > Chart of Accounts.
2. Select the account you want to deactivate.
3. Choose Edit menu > Edit Account.
4. In the Edit Account window, click the Online Settings button.
5. In the Online Account Information window, choose Not Enabled from the Download Transaction   

list and click Save.
6. Click OK for any dialog boxes that may appear with the deactivation.
7. Repeat steps for each account to be disconnected.

TASK 5: Reconnect Accounts to Park Bank Madison on or after 06/08/2020
1. Log in to www.parkbank.com and download your QuickBooks Web Connect File. 

NOTE: Take note of the date you last had a successful connection. If you have overlapping  
dates in the web-connect process, you may end up with duplicate transactions.

2. Click File > Import > From Web Connect.
3. If prompted for connectivity type, select Web Connect.
4. The Account Association window displays during setup. For each account you wish to download  

into QuickBooks, click Select an Account to choose the appropriate existing account register.

IMPORTANT: Do NOT select “New” under the action column.

5. Click Continue.
6. Click OK to any informational prompts.
7. Add or match all downloaded transactions in the Downloaded Transactions window.
8. Repeat steps for each account to be reconnected.

www.parkbank.com • Member FDIC
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QUICKBOOKS FOR WINDOWS 
UPGRADE INSTRUCTIONS
Web Connect

Introduction 
As Park Bank completes its system upgrade, you will need to modify your QuickBooks settings 
to ensure the smooth transition of your data. Please reference the dates next to each task as this 
information is time sensitive. 

To complete these instructions, you will need your login credentials for online banking.

You should perform the following instructions exactly as described and in the order presented.  
If you do not, your online banking connectivity may stop functioning properly. This upgrade 
should take 15–30 minutes. 

Thank you for making these important changes!

Documentation and Procedures 

TASK 1: Upgrade Preparation

1. Back up your data file. For instructions to back up your data file, choose Help menu > 
QuickBooks Help. Search for Back Up and follow the instructions.

2. Download the latest QuickBooks Update. For instructions to download an update, choose 
Help menu > QuickBooks Help. Search for Update QuickBooks, then select Update 
QuickBooks, and follow the instructions.

NOTE: If multiple computers do not use the same QuickBooks data file, skip step 3. 
QuickBooks activities such as Online Banking cannot be performed in multi-user mode 
because of the way the activities interact with a company data file.

3. Switch to single user mode. For instructions to switch to single user mode, choose Help  
menu > QuickBooks Help. Search for Switch to Single User Mode and follow the instructions.

NOTE: If you are not using Classic Mode (Register Mode), enable it for the upgrade. You  
can change it back after the upgrade is complete.

4. Enable Classic Mode (Register Mode).

5. For instructions to enable Classic Mode (Register Mode), choose Help menu > QuickBooks 
Help. Search for Banking Feed Modes, select Bank Feeds Modes overview, scroll down,  
and follow the instructions.
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TASK 2: Optional task - Complete a final download before 06/05/2020
1. Log in to www.parkbank.com and download your QuickBooks Web Connect file.
2. Click File > Utilities > Import > Web Connect Files.
3. Link your bank account with the existing QuickBooks account and click Continue.
4. Repeat steps for each account.

TASK 3: Match Downloaded Transactions
If new transactions were received from your connection, accept all new transactions into the 
appropriate registers.

If you need assistance matching transactions, choose Help menu > QuickBooks Help. Search for 
Matching Transactions and follow the instructions.

NOTE: All transactions must be matched or added to the register prior to disconnecting   
your accounts.

TASK 4: Disconnect Accounts in QuickBooks on or after 06/05/2020
1. Choose the Lists menu > Chart of Accounts.
2. Select the account you want to deactivate.
3. Click Edit menu > Edit Account.
4. Click on the Bank Feed Settings tab in the Edit Account window.  
5. Select Deactivate All Online Services and click Save & Close.
6. Click OK for any dialog boxes that may appear with the deactivation. 
7. Repeat steps for each account to be disconnected.

TASK 5: Reconnect Accounts to Park Bank Madison on or after 06/08/2020
1. Log in to www.parkbank.com and download your QuickBooks Web Connect file. 
2. Click File > Utilities > Import > Web Connect Files.

NOTE: Take note of the date you last had a successful connection. If you have overlapping  
dates in the web-connect process, you may end up with duplicate transactions.

3. If prompted for connectivity type, select Web Connect.
4. Click the Import new transactions now radio button, then click OK. 

NOTE: If you previously removed the check from the “Always give me the option of saving  
to a file...” option, then this dialog will not display.

5. In the Select Bank Account dialog, click Use an existing QuickBooks account.
6. In the corresponding drop-down list, select your QuickBooks account, and click Continue.
7. Confirm the prompt by clicking OK.
8. Repeat steps for each account to be reconnected.

IMPORTANT: Verify that all transactions downloaded successfully into your account registers.
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TASK 6: Re-enable Express Mode (if necessary)

NOTE: If you prefer Classic Mode (Register Mode), you are finished with your upgrade. If you  
use Express Mode for online banking, you may now re-enable the mode.

For instructions to enable Express Mode, choose Help > QuickBooks Help. Search for Banking 
Feed Modes, then select Bank Feed Modes overview, and follow the instructions.

www.parkbank.com • Member FDIC
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